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Introduction 

Adobe Captivate® is designed to help you create instructional videos, also called screen casts. 

This booklet explains how to create a Captivate project based on two primary methods: 

 import your Microsoft PowerPoint® presentation, or 

 record your screen in a Software Simulation. 

Once you have recorded into a Captivate project via one of these methods, you can add text captions, 

highlights, images, and audio recording to the project. 

The final output of your Captivate project will be either a Flash file (.swf) or an MP4 video (.mp4), both 

of which are platform-independent video files. These videos can be published to Desire2Learn, a Web 

site, or even YouTube (.mp4 only).  

Objectives 

This booklet will cover the following learning objectives: 

 Beginning a new Captivate project by: 

o Creating from PowerPoint 

o Creating a Software Simulation from screen capture 

 Editing your Captivate project, including: 

o Recording new slides 

o Deleting and moving slides 

o Adjusting slide length 

o Recording new slides 

 Recording audio in your Captivate project 

 Adding or editing Captivate objects on your slides, including: 

o Text captions 

o Highlight boxes 

o Mouse cursor 

o Images 

 Previewing your Captivate project 

 Publishing your Captivate project 
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Getting Started 

When you create a Captivate project, the files ill e ide tified  a .cpt  e te sio . B  default, the  
ill e sa ed to a folder i  M  Do u e ts alled M  Ado e Capti ate Proje ts,  though ou a  hoose 

to save to any other location on your computer. Note that projects created in Captivate 5.5 cannot be 

opened in older versions of Captivate.  

Installing Captivate 

Captivate 5.5 is a licensed software. If you have purchased Captivate and need assistance installing it, 

please contact the KSU Service Desk at x6999 (770-423-4999) or service@kennesaw.edu.  

Checking Audio Devices 

If you are going to record audio for your project, you will need a microphone and speakers. You may use 

an external headset with microphone or another type of external microphone. 

When you plug in your headset or microphone, your audio device settings should automatically change 

to the USB device. It is best to plug in this device prior to opening Captivate. 

Manually Setting Your Audio Devices 

If your headset or microphone is not automatically recognized, follow these steps to enable the device. 

1. Go to the Start menu. 

2. Select the Control Panel. 

3. Select Sound in the Control Panel. 

4. Make sure that Playback and Recording are set to the devices that you wish to use (see Figure 1 

and Figure 2). 

 

Figure 1. Playback settings in Sound control panel. 

 

Figure 2. Recording settings in Sound control panel. 

Launching Captivate 

To open Captivate, go to Start  All Programs, and select Adobe Captivate 5.5. 

mailto:service@kennesaw.edu


 

 

Updated 5/9/2014  Page 7 of 34 

 

Starting a Project from a PowerPoint Presentation 

Captivate allows you to create videos using Microsoft Office PowerPoint presentations. You can import 

PowerPoint slides into any project and add audio, captions, images, and highlights in Captivate.  

Importing Your PowerPoint into Captivate 

Follow the steps below to import an existing PowerPoint presentation into Captivate. 

1. Open Captivate. 

The splash screen should appear (Figure 3): 

 

Figure 3. Creating a new Captivate project from an existing PowerPoint file. 

2. Under Create New, select From Microsoft PowerPoint. 

Note: If the splash screen does not appear, select the File menu  New Project  Project from MS 

PowerPoint. 

3. Browse to and select the PowerPoint presentation on your computer. 

4. Click Open. 

5. Name your project. 

6. Set the dimensions for your project (Figure 4).  

 

Best Practice: Projects intended for the Web are usually sized between 800x600 and 1024x768. 

Captivate imports PowerPoint slides at their native size. You may resize the project, depending on how 

you plan to publish your project. 
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Figure 4. Selecting size options for your Captivate project. 

a. Check Maintain aspect ratio if you change the size of your imported PowerPoint slides. 

This ensures that the slide images are not distorted as you change the resolution. 

b. Select one of the Preset Sizes depending on which medium you plan to use to publish 

your project. Many Preset Sizes are available, including original PowerPoint size, Apple 

iPad, Apple iPhone, YouTube widescreen HD, and multiple screen resolutions. 

c. Select the method for advancing slides by clicking the Advance Slide dropdown. 

i. On mouse click advances slides only when the viewer clicks the mouse button. 

ii. Automatically advances slides after a set period of time. This time limit is 3 

seconds by default but can be adjusted later. 

7. Click OK. 

8. Captivate will import your PowerPoint, creating 1 Captivate slide per selected PowerPoint slide. 

9. Save your Captivate project so far by selecting the File menu  Save. 

The next section of this document describes how to create a software simulation instead of a 

PowerPoint-based project. Skip to the section The Captivate Editing Environment to continue your 

PowerPoint-based project. 
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Captivate Software Simulation Project 

Adobe Captivate 5.5 allows you to create software simulations by capturing you screen. After you begin 

recording, Captivate captures your screen when you click or enter text. Captivate also generates 

highlight boxes and text captions during the capture. You have full control to edit the capture after it is 

created, including deleting slides, recording new slides, modifying text captions, and adding audio.  

Creating a Software Simulation 

Follow the steps below to create a new software simulation. 

1. Open Captivate. 

The splash screen should appear (Figure 5): 

 

Figure 5. Select Software Simulation from the splash screen. 

2. Under Create New, select Software Simulation (Figure 5). 

Note: If the splash screen does not appear, select the File menu  Record New Project. 

3. The Software Simulation settings screen will appear, along with a red box indicating the 

recording area (Figure 6). 
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Figure 6. Software Simulation settings and recording area, indicated by a red box. 

4. Make the desired selections for your software simulation. Recommended settings: 

a. Set the size of the screen area to be captured. Many presets are available in the Custom 

Size dropdown; this tutorial will use the 1024 x 768 size. 

b. Under Recording Type, choose Automatic and check the Demo box. 

c. Make sure No Panning is selected. 

d. Make sure No Narration is selected. (Audio will be recorded separately.) 

5. Resize your application window to fit within the red rectangle. 

Best Practice: Hide distracting toolbars while recording, such as your Favorites or Bookmarks. This will 

also open up more screen room for the content of your software simulation. 

6. Click the Record button. 

7. After a 3-second countdown, recording will begin. 

8. On your computer, complete the steps you want to demonstrate via this Captivate software 

simulation. Each time you click or enter text, Captivate will record that action. 

9.  To pause recording, press the Pause button on your keyboard.  

Press Pause again to resume recording.  
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10. To end recording, press the End button on your keyboard.  

 

 

11. After you press End, Captivate will process your software simulation into slides. This may take a 

few moment, especially if your capture was long. 

12. Save your Captivate project so far by selecting File  Save. 

After creating your Software Simulation, you can modify it to your needs.  

The Captivate Editing Environment 

The Captivate editing environment provides various panels, bars, and windows to help you arrange your 

Captivate slides. The editing environment, also known as the Workspace, will help you create a seamless 

presentation (Figure 7). 

 

Figure 7. The Captivate editing environment. 

A. Save – Quickly save your project. 

B. Application Bar – Contains various application menu such as File, Edit, View, etc. 

C. Tabbed Document Window – Allows you to view multiple projects simultaneously. 
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D. Current Slide – View the currently selected slide. 

E. Inspector – Allows you to manipulate slide properties such as transitions and appearance. 

F. Object Toolbar – Tools to insert text, highlighting, and navigation effects are listed here. 

G. Filmstrip – Displays all the current slides in your project. Use the filmstrip to navigate within 

your Captivate project. 

H. Timeline – Displays slides in a timeline which can be adjusted to meet your needs. 

Project Properties and Settings 

Captivate is a complex application with many properties, preferences, and settings. Listed below are 

some of the properties and settings that affect your Captivate project. 

Project Properties 

Set the properties for your Captivate project by following the steps below. 

1. Go to File  Project Info 

2. Set the Project name, Author, Company, Email, Website, Copyright, and create a Description of 

your project (Figure 8). 

 

Figure 8. Project properties. 

3. Click OK. 
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Audio Settings 

You may record audio in the slides of your Captivate project. Next, we will explore the audio settings. 

Preparing Audio Settings 

1. Go to the Audio menu, then select Settings. The Audio Settings window will appear (Figure 9). 

 

Figure 9. Audio settings window. 

2. Make sure your microphone is selected in the Audio Input Devices dropdown.  

3. Select Calibrate Input. 

4. The Calibrate audio input window appears. Select Auto calibrate (Figure 10). 

 

Figure 10. Calibrating audio. 

5. Speak into your microphone until Input Level OK appears. 

6. Click OK to accept the calibration. 

7. Click OK to close your Audio Settings. 
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Editing Your Captivate Project 

After you have created a new Captivate project, you may wish to edit the project. These edits may 

include changing the display duration of slides, removing slides, recording new slides, or moving the 

slides. The following sections detail these adjustments. 

Adjusting the Display Duration of All Slides 

When you create a new Captivate project, the default display duration of each slide is 3 seconds. Follow 

the steps below to change the default duration for all slides within your project. 

1. Select all the slides in your Filmstrip by right-clicking on any slide and clicking Select All Slides. 

2. Select the Properties panel on the right side of the screen (Figure 11). 

 

Figure 11. Changing the display time for all slides. 

3. Type in the desired Display Time in seconds. 

4. Hit the Enter key on your keyboard. 

All selected slides now have the new display duration. 

Adjusting the Display Length of a Single Slide 

When you create a new Captivate project, the default display duration of each slide is 3 seconds. Follow 

the steps below to change the duration for single slides within your project. 

1. Select the slide you want to adjust in the Filmstrip. 

2. Find the Slide item in the Timeline (Figure 12). 

 

Figure 12. Expand slide duration in the slide's Timeline. 
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3. Cli k a d drag the right e d of the slide’s ti eli e e tr  to the right u til ou rea h the desired 
duration for the slide. 

This selected slide now has the new display duration. 

Moving Slides within Your Project 

To move a slide within your Captivate project, follow the steps below (Figure 13). 

 

Figure 13. Moving a slide by dragging on the Filmstrip. 

1. Locate the slide you need to move in the Filmstrip. 

2. Click and hold the mouse button on the slide to be moved. 

3. Holding down the mouse button, drag the slide to the new location. 

4. Release the ouse utto  i  the slide’s e  lo atio . 

Once you release the mouse button, your slide is moved to the new location. 

Removing a Slide from Your Project 

To remove a slide from your Captivate project, follow the steps below. 

1. In the Filmstrip, right-click on the slide you need to remove. 

2. Select Delete in the dropdown menu (Figure 14). 
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Figure 14. Deleting a slide. 

3. Click OK at the prompt (Figure 15). 

 

Figure 15. Deleting selected slide(s). 

The slide is removed from your Captivate project. 

Recording Additional Slides in Your Existing Project 

It is easy to record additional slides at any place within your existing project. 

1. In the Timeline, select the slide after which you want to record new material. 

2. In the top toolbar, select the red Record  icon. 

3. Confirm that you have chosen the correct slide after which the recorded slides should be 

inserted (Figure 16). 
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Figure 16. Record Additional Slides. 

4. Click OK. 

5. Click Record. 

6. After a 3-second countdown, recording will begin. 

7. When you have finished recording your additional slides, hit the End button on your keyboard. 

Your additio al slides ill appear i  the spot ou spe ified i  our proje t’s Ti eli e. 

Showing the Mouse Cursor 

In software simulations, you may wish to show or adjust the mouse cursor on your Captivate slides. The 

mouse cursor is usually displayed by default in a software simulation. However, you can add, remove, or 

adjust the mouse cursor. 

Adding the Mouse Cursor to a Slide 

To add the mouse cursor to a slide, follow the steps below. 

1. In the toolbar, select the Insert Mouse  icon. 

Note: If the Insert Mouse icon is grayed out, the mouse is already shown on the slide and does 

not need to be added. Proceed to step 3. 

2. The mouse cursor will appear on your slide. 

3. Click and drag the mouse cursor to move its location on the slide. 
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Removing the Mouse Click Sound from All Slides 

B  default, a ouse li k sou d  is pla ed he e er the ouse is li ked i  our soft are tutorial. If 
you want to remove this noise from your project, follow the steps below. 

1. Select any slide where the mouse is shown.

2. Select the mouse, either by clicking it on the displayed slide or selecting it in the slide timeline.

3. The mouse Properties should be displayed in the Properties panel at the right (Figure 17).

Figure 17. Removing the Mouse Click Sound from All Slides. 

4. Uncheck the Mouse Click Sound checkbox.

5. In the top-right corner of the Options bar, click the arrow  icon. 

6. Select Apply to All Items of This Type.

The ouse li k sou d is o  re o ed fro  our proje t’s slides. Remember to repeat these steps if 

you record additional slides. 

Inserting Images 

Captivate enables you to insert images into your project. The image becomes an object on the slide 

timeline that can be manipulated. You can get images for your project from the web, from a digital 

camera, from a scanned photograph, or from a screen capture saved as an image file.  

Images can be inserted into your Captivate project two ways. One method allows for resizing of the 

image on the slide, and one fills a slide completely with the image.  
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Inserting an Image into Your Project 

1. From the Insert menu, select Image.

2. Choose the image on your computer that you would like to upload and click Open.

The new image is now inserted in your Captivate project as an object. It can be re-sized by dragging one 

of the corners (see Figure 18). 

Figure 18. Resize an image by dragging a corner. 

You can also move the image on the slide by clicking and dragging it. 

Inserting an Image Slide into Your Project 

1. From the Insert menu, select Image Slide.

2. Choose the image on your computer that you would like to upload and click Open.

3. If the i age is s aller tha  our proje t’s slide size, the image will automatically be placed in

the center of a new slide (see Figure 19).

Figure 19. Image placed in the center of a slide. 



 

 

Updated 5/9/2014  Page 20 of 34 

 

4. If the image is larger than your project’s slide size, ou ill re ei e the Resize/Crop Image 

window. You can then customize the image before placing it into the slide (see Figure 20). 

 

Figure 20. Resize/Crop Image window. 

a. Choose to Fit to Stage to automatically fit you image on the slide, or 

b. Choose Crop to crop your image. 

c. Click OK. 

Inserting a Text Caption 

A text caption is an object that displays text on your project slides. A caption can be formatted as plain 

text, a text box, or a callout. Once added to your slide, the caption box appears o  the slide’s timeline, 

like all the other objects on the slide. 

Follow the steps below to add a text caption to your slide. 

1. Select the slide to which you want to add the caption. 

2. Click the Insert Text Caption  icon in the Toolbar.  

3. The new Text Caption will appear in the center of your slide (Figure 21). 

4. Type your text for this caption. 

 

Figure 21. A new Text Caption. 
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Modifying the Appearance of a Text Caption 

Use the Properties tab to modify the appearance of a text caption 

(Figure 22). 

You can change the following properties: 

a. Caption type—change the color and style of the caption. 

b. Callout type—choose a rectangle text box or a speech 

bubble with directional tail. 

c. Font—change the font and font appearance, including 

size, color, and text effects. 

d. Alignment—choose left, center, or right alignment. 

e. Numbering—choose numbering or bullets for a list. 

 

 

Modifying the Display Time of a Text Caption 

The text caption box becomes another object on the slide 

timeline, usually with a default display time of 3 seconds. You can edit 

the timing for the caption to appear and disappear. 

1. Click to select the text caption in the Timeline. 

2. Click and drag from side to side to move the caption on the timeline (Figure 23).  

 

Figure 23. Move the caption on the timeline with the hand icon. 

3. Hover at the start or end of the text caption, then click and drag to expand the display time 

(Figure 24). 

 

Figure 24. Expand the display time on the timeline with the arrow icon. 

Figure 22. Properties of a text caption. 
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4. Right-click and select Show for the rest of the slide to extend the caption for the remainder of 

the slide display time (Figure 25). 

 

Figure 25. Show the text caption for the rest of the slide. 

Inserting a Highlight Box 

A highlight box is an object that enables you to bring attention to areas of your slide. The highlight box 

appears on the timeline like all the other objects on your slide. You can edit the timing for the highlight 

box to appear and disappear. 

Adding a Highlight Box to Your Slide 

1. Select the slide where you want to add the highlight box. 

2. Click the Insert Highlight Box  icon in the Toolbar. 

3. Click and drag to move the highlight box on your slide (Figure 26). 

4. Click and drag the corners of the highlight box to resize it appropriately. 

5. Set the frame color, frame width, fill color, fill (color and transparency), and stroke settings. 

6. Modif  the highlight o ’s displa  ti e o  the Ti eli e as des ri ed i  the pre ious se tio , 
Modifying the Display Time of a Text Caption. 
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Figure 26. Inserting and modifying a Highlight Box. 

Recording Audio 

You can record audio for one slide, or you can record audio for the whole project and split it for each 

slide after the fact. In this document, we will record audio for one slide at a time. 

Note: Be sure to set up your audio devices. Refer to the Getting Started section of this document for 

instructions. 

Recording Audio for a Slide 

1. Select the slide for which you want to record audio.

2. Click on the Record Audio icon  in the top toolbar. 

3. The Slide Audio window will appear (Figure 27).
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Figure 27. Slide Audio window. 

4. Verify that the correct audio device is selected (top right). 

5. Click the red Record Audio icon . 

Note: If you have not calibrated your audio input, you will be prompted to do so. Refer to the 

instructions in the Preparing Audio Settings section of this document for instructions. 

5. The audio recording will begin after a three second countdown (Figure 28). 

 

Figure 28. Countdown to recording. 

6. Click the Stop recording  icon when you are finished recording. 

7. To hear your recorded audio, click the Play  icon.  

8. If you are not satisfied with the recorded audio, click the red Record Audio icon to re-record. 

9. When you are satisfied with the record audio, click Save. 

10. If the audio track is longer than the slide display time, you will be prompted to extend the 

display time of the slide (Figure 29). Click Yes. 
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Figure 29. Extend the display time of the slide for longer audio tracks. 

The audio is now attached to the slide. 

11. The audio is added to the slide Timeline. You can click and drag the audio file to adjust the audio 

timing on the slide (Figure 30). 

 

Figure 30. Audio track shown on the slide Timeline. 

Best Practice: Always set the slide to display slightly longer than the audio track. This prevents your 

audio track from being cut off. You can grab the right end of the slide timeline and drag to the right to 

extend the slide display time. 

Editing an Audio Track 

To edit your audio track, follow the steps below. 

1. Double-click the audio track in the slide Timeline. 

2. The Edit Audio window will open. 

This window enables you to edit the audio track (Figure 31). 
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Figure 31. Edit slide audio. 

Best Practice: If your track requires more than light editing, it may be easier to re-record the track. Most 

edits will involve only inserting silence or removing clips. 

Removing Parts of the Audio Track 

1. Click and drag to select the area of the audio track you need to remove.

2. Click the Cut  icon or use the keyboard command Control-X. 

3. Click Save.

4. Click Close.

Inserting Silence 

Inserting silence in an audio track is a great way to cover up distracting vocal artifacts, such as mouth 

noises or audible inhales. Because you are inserting silence on top of the noise, the length of your audio 

track remains the same. 

1. Click and drag the area of the audio track that you would like to silence.

3. Click the Insert Silence  icon or use the keyboard S key. 

4. Click Save.

5. Click Close.

Previewing Your Captivate Project 

After you edit your Captivate project, you should preview it to ensure the edits are acceptable. 
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Captivate allows you to preview your slides or project in several ways: 

 The currently selected slide 

 The entire project 

 The entire project starting from the current slide 

 The next 5 slides from the current slide 

 The entire project in a web browser 

To preview your project, follow the steps below. 

1. Click the Preview  icon on the main toolbar. 

2. Select the desired type of preview (Figure 32). 

 

Figure 32. Previewing your project. 

Removing Unused Elements from Your Captivate File 

As you work on your Captivate project, Captivate saves the elements (e.g., images and audio) that you 

have deleted. This is helpful if you have deleted an element but need to add it back. However, this also 

makes your .cptx file much larger. Captivate may even prompt you when opening an in-progress project, 

The follo i g proje t s  ha e a  u used ite s.  Figure 33). 

 

Figure 33. Unused items in a Captivate project contribue to bloated file size. 

Follow the steps below to remove the unused items from your project. 

Best Practice: You should only remove the unused items when you are finish up your project and are 

sure that you will not need those items. 
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1. Go to the Library panel in your Captivate project (Figure 34). 

 

Figure 34. Deleting unused items from your project library. 

2. Click the Select Unused Items  (broken link) icon. 

3. All the unused items will be highlighted. 

4. Click the Delete  (trash can) icon. 

The unused items are now removed from your project. Next time you save, the file size will be reduced. 

Publishing Your Captivate Project 

When you are finished editing your project, you will need to publish it. When you publish a project, all of 

the slides and objects are rendered into a web-friendly format. 

This document will discuss 2 publishing options: Flash (.swf) or video (.mp4). See the next 2 sections for 

information about each publishing option. 

Best Practice: You should always keep the original .cptx file so that you can make changes and re-

publish if needed. 

Publishing Your Project in Flash Format 

If you have any interactive elements in your Captivate project, you will want to publish in Flash format. 

Flash will maintain interactive elements, such clicking to advance slides, or allowing user input. 
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To publish your project in Flash, follow the steps below. 

1. Click the Publish  icon on the main toolbar, or select the File menu  Publish. 

2. On the left side of the Publish window, make sure the Flash (SWF) option is selected (Figure 35). 

 

Figure 35. Publishing to Flash. 

3. Select the following options (refer to Figure 35): 

a. Click the Browse button to choose the folder on your computer where you wish to 

publish this project (such as My Documents or Desktop). 

b. Select the Export to HTML checkbox under Output Options. 

c. Select the Zip Files checkbox under Output Options. 

4. Click the Publish button. 

A zipped folder will be created. The zipped folder contains 3 files (Figure 36): 

 

Figure 36. Published Flash component files. 
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 Main Flash file (.swf), which is the core output of your project and the largest file. 

  JavaScript file (.js), which is needed for your project display correctly in the Web browser. 

 HTML file (.htm) in which your project is embedded. This is the file you will link to on a Web site. 

Sizing and display properties are also embedded in this file. 

You will need all 3 files to publish your Flash project online. 

Publishing Your Project in Video Format 

If your Captivate project does not include interactive elements, you can publish it as a video file (.mp4). 

It is mobile-friendly, so it can be viewed from a device like an iPad. 

To publish your project as a video, follow the steps below. 

1. Click the Publish  button on the main toolbar, or select the File menu  Publish. 

2. On the left side of the Publish window, select the Media option. 

3. Select the following options (refer to Figure 37). 

 

Figure 37. Publishing as an MP4 Video file.. 

a. In the Select Type dropdown, choose MP4 Video (*.mp4). 

b. Click the … (Browse) button to choose the folder on your computer where you wish to 

publish this project (such as My Documents or Desktop). 

4. Click Publish. 

Your project will be published as a single MP4 video file in the location you specified. 
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Uploading Your Project in Desire2Learn 

After publishing your project from Captivate (see the previous sections on Flash or Video/MP4), you can 

upload your project output in a Desire2Learn course section. 

Uploading Your Flash-format Project 

1. Open your Desire2Learn course. 

2. Go to the Content menu item. 

3. Select Table of Contents from the left menu in the Content area (Figure 38). 

 

Figure 38. Accessing Table of Contents. 

4. Select the Related Tools button (Figure 39).  

 

Figure 39. Related Tools button. 

5. From the dropdown that appears, select Manage Files (Figure 40). 

 

Figure 40. Manage Files in the Related Tools dropdown. 

6. Select the New Folder  icon to create a folder for your project. 

7. Enter a Name for the folder and click Save. 

8. Click on the name of the new folder to enter that folder. 

9. Click the Upload  icon. 

10. Click Browse. 

11. Locate your zipped, published Captivate project on your computer and select it. 

12. Click Open. 

13. Click Upload. 
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14. Your zipped folder ill e uploaded to our ourse’s Desire2Lear  files. 
15. Hover to the right of your .zip file, and a dropdown arrow will appear (Figure 41). Click the 

dropdown arrow. 

  

Figure 41. Dropdown arrow appears when you hover next to an item in Manage Files. 

16. Select Unzip from the dropdown menu (Figure 42). 

 

Figure 42. Unzip the zipped folder in Manage Files. 

17. The .htm, .swf, and .js files will unzip into the folder you created in Step 6. 

18. Hover to the right of the .htm file; a dropdown arrow will appear. Click the dropdown arrow. 

19. Select Add Content Topic (Figure 43). 

 

Figure 43. Select Add Content Topic for the HTML file. 

20. The Add Multiple Topics screen will appear (Figure 44). Make the following selections: 
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Figure 44. Selections to add your Flash project to a module. 

a. Choose a Parent Module, or click [add module] to create a new module. 

b. Change the Topic Title, if desired. 

c. Click Add. 

The Flash project is now accessible for your students. 

Uploading Your MP4 Video-format Project 

1. Open your Desire2Learn course. 

2. Go to the Content menu item. 

3. Select the desired Module from the left menu in the Content area (Figure 45). 

 

Figure 45. Choose a module. 

4. Select the New  button. 

5. Select Upload Files . 
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6. The Add a File screen will appear. Either drag and drop your MP4 video to this screen (Figure

46), or click the Upload button and select the MP4 file from your computer files.

Figure 46. Add a File to the module. 

7. Click Add.

The video is now available for your students to view. 

Additional Support 

To receive additional assistance with Captivate, contact the KSU Service Desk either by phone or email: 

 Phone – 470-578-6999

 Email – service@kennesaw.edu

mailto:service@kennesaw.edu

